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Introduction to NVivo: Project Set-Up & Coding 
NVivo can do a phenomenal number of things to help you analyse your qualitative data. It can 
also help you analyse a large variety of data types: text, audio, video and pictures. This course 
will show you how to use the essential tools available in NVivo for qualitative data analysis. 
For further information about NVivo’s full capabilities, please refer to the NVivo 11 help 
website (NVivo 12 comprehensive is not yet available): help-nv11.qsrinternational.com 

This session will cover: 

• Recommended steps in setting up a Research Project in NVivo. 

• How to set-up Case Classifications, Attributions & Values to use as break-down 
variables (a.k.a. independent variables) for future analysis.  

• How to set-up Data File Classifications, Attributions & Values to use for bibliographies 
and refining searches and analyses.  

• How to create, view and organise coding schemes in the Codes area. 

• How to Import Data Files. 

• How to create Cases and apply Attribute values. 

• How to Auto Code to create contextual Nodes and Cases. 

• How to manually code and uncode text, sound, picture, and video. 

When you open NVivo it will ask you to create a user ID: enter your Initials (must be unique to 
the Project) and (optional) your name. This is important when you’re collaborating with others.  

Open the sample project to explore how NVivo can be used to analyse your data. When you 
open NVivo, on the Start Screen in the New section click Sample Project. This is a two-year 
study (2008-2009) documenting community perceptions of development and land-use change 
on coastal communities in the Down East area of Carteret County, North Carolina, USA. 

NOTE: Saved Projects can be opened on any computer only if it has the same version of NVivo 
(e.g., NVivo 12 Pro for Windows) and can be altered by any collaborator (a record of who 
changes what is kept according to User ID). Windows Projects can be converted to Mac to 
view on Apple computers, and vice-versa. Please be aware that Mac versions do not have 
the same capabilities as Windows versions of NVivo (e.g., you cannot Auto Code on 
Macs). 

Recommended Steps in Setting up an NVivo Project 
It may seem counterintuitive, but setting up an NVivo Project is more efficient if you create 
your research project variables BEFORE importing any data.  
The recommended steps are as follows: 
 
1. Identify what your Cases will be (your units of measurement, such as people/ reports/ organisations). 

Then set up your Case Classifications, Attributes and Values (e.g., “independent” or grouping variables) 
for later analytical comparisons in the Cases Area (e.g., age groups, gender, states/territories). 

2. Set up your Data File Classifications, Attributes and Values to keep track of bibliographical information 
and help refine future analyses (e.g., analyse survey data separately from interview data) in the Data 
File Area. 

3. Import your Data in the Data Files folder and create Cases and assign Classifications simultaneously.  
4. Open Classification Sheets and assign Attribute values to your Data Files and Cases. 
5. Create Contextual Nodes if needed (e.g., a Node each survey question) using Auto Coding. 
6. Set up your Research/Thematic Variables in the Codes Area, and other Contextual Nodes 

(e.g., Attitude: positive, negative, neutral). 
7. (Optional) Prepare your project for collaboration, in Sets and/or Memos. 
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The NVivo Workspace 
The Navigation View is where you can easily navigate the different Areas of your NVivo 
Project. When you click on an Area in the Navigation Pane, a list of folders in that Area 
appears at the top of the pane. When you click on a folder, the list of items it contains is 
presented in a window to the left called the List View. When you open an item in the List 
View, its content appears in the Detail View. The Ribbon contains commands in tabs. The 
Find Bar is a shortcut to search for items your Project. The Quick Coding Toolbar has 
shortcuts for coding your data. The Status Bar provides information for the Project Item you 
have open. 

 

Note: Throughout using NVivo you’ll find that your best-friend is Right-Clicking: it gives you 
a context-dependent short-cut menu with all the appropriate options for the space/object 
clicked. This way you don’t have to remember which menu tab has the function you need. 

Note: The Navigation View can be hidden to make more room on the screen by clicking the 
arrow symbol at the top right-hand side of the View.  

Mac vs PC Versions of NVivo 
If you are intending to use the Apple Mac version of NVivo, please note that it does not have 
all the capabilities of the PC version and the user interface can be quite different (e.g., The 
Mac version cannot Auto Code). In newer versions of NVivo, the interface is becoming more 
similar, however the older versions are vastly different. These notes apply to the PC version 
only, so if you are working on a Mac and have trouble finding what you need please refer to 
the online NVivo 11 Help for Mac: 

help-nv11mac.qsrinternational.com 

If you are working on both PC and Mac versions, you will need to convert your Project files to 
the appropriate format to the platform you are working on, each time you work on a different 
computer. More information on how to do this can be found on the above website. 

 

  

1. Ribbon 

2. Navigation 
View 

3. List View 

4. Detail View 

5. Find Bar 

6. Quick 
Coding  
Toolbar 

7. Status Bar 
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FIRST STEPS: Define Cases & Data Files, Create 
Classifications, Attributes and Relationships 
Defining the higher-order information about your Data Files and Cases.  

HANDY HINT: By defining the Case and File classifications, their attributes and values FIRST, 
you are able to classify your data DURING the import process. This saves a lot of time, 
particularly because it has the added benefit of ensuring you plan your project thoroughly 
before you start coding. 

What are Cases? 
Technically, Cases are the units of measurement for your research. They can be individual 
people/reports/articles (or other special instances you wish to be able to measure) in your 
project design. For example, if you want to be able to say: “N number of People said Y”, then 
People will be your Cases. You can have multiple types of Cases if you have more than one 
unit of measurement (e.g., a Case type for Person and a Case type for Organisation).  

In order to help NVivo identify individual Cases for analysis, you need to create a Case Node 
for each one. Case Nodes also allow you to see all the content relating to each Case (e.g., 
everything person A said) when you open them. These are filed as special types of Nodes in 
the Cases folder in the Cases Area.  

What are Classifications? 
There are two types of Classifications you need to create in your project: 

• File Classifications – for each type of Data File in your project (e.g., Interview, Article or 
Web Page). You will often only have one type of data file. Sometimes File Classifications 
are not even necessary, as they are only useful for searches within NVivo. 

• Case Classifications – for each type of Case in your project (e.g., Person, Organisation, 
Location). You will often only have one type of Case. Case Classifications are necessary 
unless you are not interested in enumerating your data or analysing it at different levels 
(e.g., comparing age groups or summarising what a particular group says). 

What are Attributes & Values? 
For each Classification you will usually need to create a set of unique, mutually exclusive 
Attributes:  

• Data File Attributes – the relevant details about your data files that you need to keep 
track of (e.g. bibliographical information, interview details such as time place and 
interviewer). Note: can import bibliographical information from referencing programs such 
as EndNote.  

• Case Attributes - the relevant breakdown variables (a.k.a. independent variables) you 
will need for analysis. E.g. if you believe that there will be differences due to the 
states/territories in which the Cases live, then state/territory should be an Attribute of the 
Classification for Person.  

Within each Attribute you will usually define a set of possible Values to use for analysis 
(e.g., within Sex the options are Male or Female). This allows you to choose values from a 
drop-down menu rather than having to type in all your data.  

Note: Attributes must be mutually exclusive because you cannot select more than one 
Attribute Value per Case or Data File. For example, if you have a Case Attribute for Fishing 
with values for Commercial and Recreational, if a Case fits into both categories you cannot tick 
both boxes. In this instance you have to create an Attribute for Commercial Fishing and 
another for Recreational Fishing with values of Yes and No. 
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Below is an example of a Case Classification for Person with Age, Sex and Occupation 
Attributes. This will allow for comparison of the themes that emerge in your data between 
3 age groups and sexes. 

 

   

Creating Classifications and Associated Attributes 
You need to set up classifications for Data Files and Cases in different areas in NVivo12: Case 
Classifications in the Cases area, and File Classifications in the Data Area. The process is 
identical. 

Example: Create a Case Classification and Attributes for Philosopher.  
On the Home tab, click on the drop-down menu for Case Classification (or you can right-
click on the Case Classifications icon in the Cases area). Create a new Case Classification called 
“Philosopher” and give it an (optional) description. This will create the classification and then 
you can add its Attributes. Click on the new Philosopher Attribute and on the Home tab 
select New Attribute (you can also do this by right-clicking on the icon for Philosopher and 
selecting New Attribute). Give it a name and (optional) description, such as Nationality on 
the General tab. Select its value Type (here text). On the Values tab, you can set up the 
different nationalities for the attribute: click Add and enter a new value in the row that 
appears (e.g., French) assign a description and/or colour if you wish, then click Add again to 
add the others. Then click OK when you’ve finished (do not click ADD again as it will not let 
you continue with a blank row). You can add more attributes to the Philosopher classification 
this way as well. 

HANDY HINT: You can delete and reorder Attributes by clicking on the arrow on the left-
hand side of the row you want to remove or delete to highlight it, and then click on the 
appropriate button below (remove, move up or move down). 

Applying Classifications & Associated Attributes 
When you have imported your Data Files and Cases in the Project you need to associate them 
with their relevant Classifications and assign Attribute values. If you haven’t already 
assigned a Classification to your Cases during import, do this by selecting one or more 
Cases, right-click on the selection and go to the Classification section of the menu and 
choose the appropriate one (e.g., Person or Journal Article). Once the Files/Cases have been 
classified, they will then be available for classification in the Classification Sheet which is 
found in the Classifications Area of the Navigation View. 
 

Person

Age

20-25

26-30

31-35

Sex

Female

Male

Other

Attribute Values Classification 
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Find the relevant Classification (e.g., Person) and double-click on it to open the Classification 
Sheet (or right-click on the Classification and select Open). This will produce a new tab with a 
spreadsheet. The columns represent each Attribute and rows represent each Data File/Case. 
Select the appropriate Attribute values in each column for every Data File/Case in each row 
(either using drop-down lists or typing them in).  
 

HANDY HINT: If you need to apply the same value to multiple consecutive Cases in the 
Classification Sheet, you can copy a cell with the relevant value and paste that value to 
multiple cells after selecting them using the shift + arrow keys (Note: you cannot select 
multiple cells with the mouse). 

DATA AREA 
Importing Files 
This is where you’ll store all of your qualitative data files for analysis (e.g., interviews, surveys 
results).  

There are 3 Data Area folders: 

• Files: previously called “Internals” in NVivo 11. All the data files you want to analyse using 
NVivo should be stored here within the Project itself. 

• Externals: links to data and notes which you don’t need NVivo to analyse can be stored 
here outside the NVivo Project (e.g., things that you cannot import into NVivo like 
PowerPoint slides, or really big files that are better to store outside to save computing 
power).  

• File Classifications: where you can create File Classifications, Attributes and Values for 
your data files in the same manner as for Cases. 

HANDY HINT: NVivo analyses data files quicker and more easily with less data to search 
through in a Project. You can save the material not needed for analysis in the Externals 
folder OR if you want to use NVivo for your literature review, create a separate Project 
for that.  

You can see the data files already imported into the Project by clicking on the File folder and 
the list of files will be displayed on the right in the List View Window Pane. To see the actual 
data within the file, double-click on the file and it will open up in a new Window Pane called the 
Detail View on the right-hand side of the screen.  

New folders can be created within the Data Area by right-clicking on the File folder, selecting 
New Folder and giving it a name (e.g., “Test Folder”) and (optional) description. You can also 
create new Internal Documents by right-clicking in the List View and selecting New Internal 
and new Document (new audio and video files will still need to be imported). Give it a name 
and (optional) description. 

Importing Data Files into the NVivo Project 
You can import data files in the following formats in NVivo Pro/Plus (only text in the Starter 
version): 

Data Files  

• Text: *.doc, *.docx, *.pdf, *.rtf, and *.txt 

• Audio: *.mp3, *.mp4, *.m4a, *.wma, and *.wav 

• Picture: *.bmp, *.gif, *.jpg, *.jpeg, *.png, *.tif, and *.tiff 

• Video: *.mpg, *.mpeg, *.mpe, *.wmv, *.avi, *.mov, *.mp4, *.qt, *.3gp, *.mts and *.m2ts 
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Survey Files 

• Excel: *.xls, *.xlsx, *.csv, *.txt, *.tsv, Access database tables, ODBC database. 

• Survey Monkey 

• Qualtrics 

Web Pages: as PDF files using NCapture for Chrome and Internet Explorer. 

Bibliography Files: EndNote, Mendeley, RefWorks and Zotero files. 

Notes and Email: Memos, Evernote, OneNote and Outlook files.

Social Media: as Survey Files from Facebook, YouTube, LinkedIn and Twitter using 
NCapture. 

HANDY HINT: You can select multiple files and import them into NVivo at the same time 
(although datasets must be imported one-by-one). However, you will need to define the file 
properties after import, and NVivo will use the file name as the name of the Data File/Case by 
default. 

Creating Case Nodes When Importing Data Files 
When each data file represents one Case in your project, you can automatically create a Case 
project item for it and NVivo will code all of the text etc. in the file as belonging to that Case.  
 

Example: Importing a *.doc file belonging to one Case 

In Navigation View, click the name of the File folder that you want to import the data file 
into (e.g., Internals). On the Import tab, click the icon for the type of data you want to 
import (e.g., Data Files). Select the file you want to import, then OK. If this file belongs to one 
Case (e.g., Tony), tick the box to Create a Case for each imported file and you can also 
select the radio button to Add to an existing classification to classify all the documents 
appropriately. Then click Import.  

To assign File Classifications to the imported file(s), select the files you want to classify and 
right-click on the selection. Choose Classification and select the appropriate File Classification 
from the list. You can also create Cases from the files here and assign Case Classifications 
at the same time if you haven't done this during import. 

HANDY HINT: Audio, Video, Dataset and PDF files need to be edited before import. It’s also 
good idea to spellcheck documents before importing also, although there is a spellchecking 
function in NVivo. 

Adding External Data Sources 
When you have large files, such as audio and video, it’s usually a good idea to add them to the 
project as an External Data Source rather than import them as part of the project. It 
reduces the sizes of the project file and saves on computing power when running analyses. 

Please note that you will not be able to use NVivo to analyse the content of external sources 
of data, only the notes or comments you linked to them. 

In the Externals folder, right-click on the space in the Detail View and select New External. 
Enter a name and optional description on the General tab. On the External tab choose the 
External Type (e.g., File Link) then click the Browse button to file the location of the file. The 
file MUST always go where the NVivo Project goes, or else the link will break. You can give it a 
location description and select the Contents Type from the drop-down menu and Unit Type 
from the next menu.  

On the Attributes Values tab select a Classification Type if appropriate (e.g. Reference) 
and assign its relevant Attributes. Then click OK. The external will open in edit mode and you 
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can enter content related to the external to be coded later on. If you want to open the external 
file within NVivo, right-click on the external data source and select Open External. If you want to 
open the file in its native format outside of NVivo, select Open External File instead. 

Importing Social Media and Web Pages 
NCapture 

There is an add-on for Internet Explorer and Google Chrome web browsers called 
NCapture for NVivo. It automatically converts web pages to pdf and social media 
conversations into spreadsheet tables ready for analysis.  

Web Pages 

Example: Capturing and importing a Wikipedia Page in Google Chrome. 
To save pages as pdf and import them into NVivo, go to the relevant webpage in Google 
Chrome or Internet Explorer (e.g., a Wikipedia Page) select NCapture and click Web Page 
as PDF as the data source type (or Article as PDF if you only want to save the text of the 
article. Note: sometimes the text you see on a webpage is actually an image of text, and as 
such cannot be found in searches). Change the name if you wish and (optional) enter a 
description and linked memo. You can also ask it to code the source at import by adding 
terms to the Code at Nodes box. Then click Capture.  

In NVivo, click on the Data folder in which you wish to import the data. On the Import menu 
tab, click NCapture. Select the appropriate option (All captures not previously imported, All or 
Selected). If your file is not already visible in the box below, click the Browse button and find 
the file you wish to import. Then click Import.  

Facebook/Twitter 
When you are on the Facebook page, you can only save the News Feed page or a User Wall 
as a PDF file with NCapture. Follow the same directions as for web pages above. If you are 
displaying Wall Posts for a Facebook Page or a Twitter Feed you can use NCapture to 
save the posts as a Dataset: select the option Posts as Dataset. 

Note: You can merge social media datasets into one table for ease of analysis (takes note of 
where the files came from as Nodes). Tick the Merge matching social media datasets 
(including previously imported) check box, and any matching Facebook datasets are 
merged together (if they contain wall posts for the same User, Page, or Group). 

YouTube 
You can capture the Video only, Video and Comments or the Web Page as PDF. When you 
use NCapture to capture video in YouTube, it creates a video source file which is essentially a 
shortcut link to the video in YouTube (an External Source) which can be played within NVivo. 
If the video is removed from YouTube you will not be able to play it. You can transcribe this 
video within NVivo, but not in Transcribe mode. If you also capture the YouTube comments 
this creates a dataset within NVivo as an Internal data file which can be analysed. 
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CODES AREA 
Create Nodes  
This Area contains all the information relating to the coding you have conducted to analyse and 
summarise your qualitative data. It has folders for:  

• Nodes: "Nodes" are essentially files (with a blue circle symbol) containing everything you 
have assigned to each code in your coding scheme (text, audio, video etc.). 

• Relationships: A record of the Relationships you note between project items (e.g., which 
People are Married, which Authors are Collaborators). This is information you can record 
but not analyse in NVivo Pro (you can analyse it using the Plus version). 

• Relationship Types: This is where you set up the types of relationships you want to note 
and apply to NVivo project items. 

What is a Node? 
It might be easier to think of Nodes as being the same thing as Codes. As mentioned 
above, Nodes are essentially files (with a blue circle symbol) containing everything you have 
assigned to each code in your coding scheme (text, audio, video etc.). For example, all the 
text/audio/video in the Sample Project which refers to infrastructure has been coded to a 
Node called “Infrastructure”. When you open the Node called “Infrastructure”, you will see a 
summary of all the data that was coded in the Detail View on the right-hand side. Each 
section of text, audio, and video is called a Reference.  

Nodes can be:  

• Free - stand-alone topics/themes (e.g., Balance). 

• Tree - hierarchical grouping of Nodes indicated by a +/- symbol to expand and collapse the 
tree. The higher-order Node is termed the “parent” and lower-order Nodes “children” 
(e.g., Economy is a parent Node and Agriculture, Tourism etc. are its children).  

HANDY HINT: Consider setting-up Nodes for the codes you intend to use before 
coding your data; this does help to ensure coding doesn’t go beyond the scope of your 
project. They can always be changed, merged, added to and reorganised as you go along. You 
can also use the Mind Map feature in NVivo to create your initial Node structure [more on this 
later].  

HANDY HINT: Try to restrict Tree Nodes to the “child” level, and don’t go beyond to 
“grandchildren” or “great-grandchildren” unless you absolutely have to. It makes analysis 
simpler and limits your Nodes to only the essential ones for summarising and analysing. 

HANDY HINT: NEVER duplicate nodes – there is no need to, as segments of data files can 
be coded to multiple Nodes. 

When you look at your Nodes in the List View, it also provides a summary information about 
each:  

• Files: the number of Data files that have content coded at that Node. 

• References: the number of sections of text audio and video etc. coded to that Node. 

And other potentially useful information. 
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Research Nodes and Contextual Nodes 
Your Research Nodes are essentially the ones based on your Coding Scheme. I recommend 
creating “Contextual” Nodes also in order to make future analysis easier. Contextual Nodes 
are different to your standard “Research” Nodes in that they solely provide some context to 
the data being investigated (e.g., Responses to Question 1, Negative Attitude Expressed, 
Positive Attitude Expressed) rather than being important themes you are investigating (e.g., 
Water Quality, Air Quality). They are also different to the Classification characteristics of your 
Cases, because these can already be used to group your Cases for analysis (e.g., Male, 
Female, Age Group). 

Opening a Node to View All the References Coded to It 
The List View the Nodes Area provides information regarding the number of Files that are 
coded at the Node (e.g., how many text and video files), as well as the number of References 
(sections of text). You can see the actual content of the Node by double-clicking on it (e.g., 
Infrastructure) or right-click on it and select Open Node. The content is displayed the Detail 
View. Here you will find tabs on the far right-hand side for:  

• Summary - the files in which the references are coded and how many.  

• Reference - the textual data coded with hyperlinks to the original Data file, as well as 
"coverage" details (see below) and reference numbers.  

• Other tabs with thumbnail links which compile information from Text / PDF / Picture / 
Audio etc. files separately.  

Note: If the Node is a parent and has Aggregation turned on [more on this later], then 
coding at any child Nodes is included in what you see when you open the node. The content in 
child Nodes are also included when calculating coverage. 

Warning: If you code 2 sentences next to each other separately, and do not include the space 
between them, this is counted as 2 references. In addition, if 2 people code the same sentence 
this is also counted as 2 references. 

Reference Tab Information 
• Header: Name of the File coded with a hyperlink to that file, number of references in it 

coded at the Node and percentage of coverage (e.g., X% of the File coded at this Node). 

• References: Number of times the reference was coded at the Node (>1 if multiple users 
coded the same section of text).  

• Coverage: Percentage of the file that the reference coding represents (e.g., for documents 
it represents the percentage of characters coded in the entire file). 

Creating a New Node 
You can create Nodes prior to coding if you wish; it isn’t necessary but it does help to ensure 
coding doesn’t go beyond the scope of your project. In the Codes area of the Navigation 
View, click on the Nodes folder. Right-click on the Detail View in the Nodes folder, and 
select New Node. Type in the code’s label (e.g., Schools of Thought) and add a description 
(recommended as this text will be added to the "codebook" that you can export later). 
Another method to create Nodes is to click on the Create tab, then click Node. You can also 
use the Mind Map function to create multiple hierarchical Nodes. [More on this later]. 
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HANDY HINT: It’s good practice to define what a code means and any “rules” for applying the 
it to the data. This can be added to the description of the Node in NVivo and will assist in 
ensuring reliability and validity of your coding scheme. All descriptions can be exported as a 
"codebook" when you have finished coding. If multiple people are coding the data 
(recommended on a limited sample of data for reliability checks), then there is a clear record 
of what the code means and how it should be applied in practice. It should also be noted in 
reports, so that readers can assess the meaning and validity of the code. 

Creating Child Nodes 
Right-click on the Node you want to turn into a “parent” (e.g., the Schools of Thought) and 
select New Node. Give the new Node a name (e.g., Rationalism), add a description, then click 
OK. You can also turn a Free Node into a Child Node by cutting and pasting it into the 
intended Parent Node and selecting Merge into New Child Node, or by clicking the free 
Node icon and dragging it into the Parent Node. 
 
If you decide you've made a mistake, you can make the child Node a free Node again by 
cutting and pasting the Node icon to the blank space at the bottom of the Nodes list (or by 
clicking and dragging it to the higher-order Nodes folder in the Codes area). 

Aggregation 
It’s a good idea to consider if and when you want to aggregate the coding in your child Nodes 
with that of the parent Node for analysis. Right-click on the parent Node then select 
Aggregate Coding from Children to either tick or untick the Aggregate box. If aggregation 
is turned on (ticked), then all the child-specific coding (e.g., Rationalism) will also be included 
in the parent-Node coding (e.g., Schools of Thought) during analysis. 

Note: If you have aggregation turned on for a parent Node X, but aggregation turned off for 
its child Node Y which is also a parent Node (i.e. X has "grandchild" Nodes) the content coded 
at the grandchildren will not be included at the grandparent level when viewing or analysing 
Node X.  

Changing Node Information 
If you need to change the name of a Node, simply click on the name of the Node a 2nd time 
and you can change the text. You can also change the name and anything else about the Node 
(e.g. the description) by right-clicking on it and selecting Node Properties. 

Creating Folders for Nodes 
You can create folders to organise your Nodes in some meaningful way (e.g., create a folder to 
store your survey question Nodes). Right-click on the Nodes folder to create a new one within 
it (e.g., Context Nodes). You can further organise Nodes by clicking their Node icons and drag 
them in and out of folders (e.g., drag Attitude into the Context Nodes folder).  

Merging Nodes 
You can also merge similar Nodes together so that everything that was coded at one Node will 
become coded to the Node it is merged with. Select and cut the Node you want to merge into 
another “target Node” (e.g. in the Autocoded Social Media folder cut Fisherman and Fishing) 
then right-click on the Target Node (e.g., Fishing Industry) and select Merge into Selected 
Node. Select the appropriate option(s) provided (e.g., Merge Child Nodes as well) then click 
OK.  
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[OPTIONAL] Creating a Relationship between Project Items 
You can create relationships between Cases and/or other project items, and you will see these 
relationships in the Relationships folder in the Codes area. For example, Margaret is a 
member of Carteret Catch. Relationship types need to be created FIRST in the Relationship 
Types folder.  

To create a Relationship Type, right click on the Relationship Types folder and select New 
Relationship Type. Type in a name (e.g. employer) and [optional] description, then select 
the appropriate direction (e.g. one-way). To apply a Relationship right-click in the blank space 
in the Relationships List View (or selecting Relationship on the Create tab) then select a 
Project item such as a Case/Node in the From box (e.g., Barbara), then choosing a 
Relationship Type from the drop-down menu (e.g., is married to) and selecting another 
Project item in the To box (e.g., Ken). Then click OK. 

Using Mind Maps to Create Nodes 
NVivo Mind Maps help you to create a diagram of your coding scheme and its hierarchical 
structure. As an added bonus, you can also convert the mind map “ideas” into actual Nodes in 
the Codes area with the click of a button.  

On the Explore tab click Mind Map. Enter a name for the map in the Name box, and an 
(optional) Description, then click OK. An initial shape is already prepared for you to enter a 
label for the main idea of the map (e.g., Research Project Title). The child ideas from this main 
shape will essentially be the parent Nodes of your coding scheme (otherwise you need to have 
one map for each parent Node which is inefficient).  

If you want to add a “child” idea (e.g., a shape connected to the main idea) click on the shape 
and on the Mind Map Tools tab, click on Child idea (alternatively right-click on the shape 
and select Child idea from the menu). Then give it a label (e.g., Theme 1). If you need to 
relabel it, just double-click on the word to edit. You can add a Sibling idea (a shape at the 
same level in the hierarchy) in the same way.  

If you want to create an unconnected shape that will become a free Node in your Nodes folder, 
click Floating idea on the Mind Maps Tools tab. Note: you will not be able to add siblings or 
children to the shape.  

You can change the colour of a shape by clicking on it and changing the colour from the Fill 
drop-down menu on the Mind Maps Tools tab. You can also change the layout, size, and text 
formatting on this tab. When you’re happy with your Coding structure, select Create as 
Nodes or Cases from the Mind Maps Tools tab, click on the Nodes folder and then OK. They 
will then appear in the Node folder of the Codes area.  

Note: I recommend rearranging the new Nodes to make the parent Nodes (which will appear 
as children under your main theme) true parents by cutting and pasting them to the blank 
space in the list. Then you can remove the superfluous project theme Node. 
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Autocoding Nodes & Case Nodes 
You can also create Contextual Nodes (such as a Node for each question so you can analyse 
them separately) and Case Nodes using the Autocode function. This works best if you have a 
spreadsheet Data file where each row represents one case, and each column represents a 
Node (such as a survey question). Autocode can also be used in Word documents, if you 
have used Heading Styles to define content relating to one case/theme (such as Heading 1 
for each interview question, and Heading 2 for each person's name).  

Auto Coding Datasets 
You can automatically code datasets, creating Nodes for: 

• columns – e.g., a Node for each question in a survey coding the responses in the column 
to that Node. 

• rows – e.g., a Case for each respondent and code the responses in that row to that Case.  
 
Example: Auto Code the columns in the Survey Responses Data file as question Nodes. 

In the List View of the Data area, select on the dataset you want to auto code (e.g., the 
Survey Responses Data in the Survey folder). On the Home tab click Auto Code and the 
Wizard will begin to take you through the process. Click Code at Nodes for selected 
columns then Next. Move the appropriate column(s) you wish to auto code into the Selected 
Columns box by selecting them and clicking the right arrow button (e.g., all of the available 
columns) then click Next. Select a location for the Node (e.g., under New Node in the 
location Nodes), and give the new Node a name (e.g., Survey Questions). Then click Finish. 
This will create a new parent Node called Survey Questions with multiple child Nodes in the 
Nodes folder. 

Auto Coding Using Paragraph Styles 
You can use NVivo to auto code your Word documents based on Heading Styles. It's 
probably easier to explain how this works using an example. If you want to create a Node for 
each question that is asked in an interview transcript, you can apply the same Heading Style 
format to each question asked in the document. NVivo will automatically create a new Node for 
each piece of unique text in that style (e.g., one Node called "What is your favourite colour?" 
written in style 1 and another called "What is your favourite food?" also in the same style). It 
will then automatically code the text between "What is your favourite colour?" and the next 
instance of the same Heading Style as belonging to the new "favourite colour" Node. If NVivo 
finds the text "What is your favourite colour?" in Heading Style 1 again, it will add the next 
piece of normal text to the same Node.  

If you have multiple individual transcripts in Word and they are formatted using paragraph 
styles in the same way, they can all be auto coded together in one go. 

Example: Auto Code the Interview Word Documents.  

Select the document you wish to auto code in the Data area (e.g., all the text documents in 
the Interviews folder). On the Home tab, click on Auto Code and select Paragraph Style and 
select the appropriate paragraph style(s) from the list (e.g., Heading 1 to create Nodes for 
each question). Click Next and then select a location for the Nodes (e.g., under New Node in 
Nodes) and give the group of Nodes a Name (e.g., Questions), then click Finish. You’ll notice 
in the Nodes folder there are 2 Nodes for Q.6. This is because the questions were not identical 
– you can merge these two together. 

Note: You can also Auto Code by paragraph number this way: choose to code by Paragraph 
instead of Paragraph Style. 
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Coding Your Data  

What is Coding Context? 
When you begin to code your data it’s important to consider how much information to 
include in your Nodes: individual words, partial/whole sentences, paragraphs or even the 
whole document. Ideally you should code as much content needed to understand why it was 
coded in that way.  

For example:  

“I find television very educating. Every time somebody turns on the set,  
I go into the other room and read a book.” – Groucho Marx 

If you select and code ONLY the first sentence of this quote to the Node TV is NOT 
Educational, you might later think that the coding was inappropriate, because when you open 
the Node to review it, only that sentence would appear. Therefore, when coding it is important 
that you include an appropriate amount of context in order to justify why you coded it the way 
you did – not only to yourself, but to anyone else who might review your analysis.  

On the other hand, including irrelevant information in the context of your Node can be 
problematic for analysis. Particularly if you want to identify overlapping content between Nodes 
and quantify your qualitative data. In the example below, each Node contains a substantial 
amount of irrelevant text, and there is a spurious relationship between them because only the 
irrelevant coding overlaps. 

 

What is "Coding-On"? 
Often one sentence will be a relevant reference for more than one Node. Coding-on refers to 
coding the same content at a second, third or fourth Node+ (this is done in the same way as 
regular manual coding). This is why you never need to have duplicate Nodes. 

How to Code a Section of Text to a Node 
Method 1: Manual coding.  

Open a document from the Data area and Files folder of the Navigation View. Click and 
drag your mouse to highlight the section of text that you would like to code under one or more 
Nodes. Right-click on the selection and choose Code from the menu. Then choose one or more 
of the existing Nodes in the list: to select more than one hold down the control key and click 
on the Nodes. If you need to create a new Node, click the New Node button at the bottom of 
the new window. This will add a new blank Node to the list, which you can rename and select. 

  

Irrelevant
 

C
onjunction

 

Irrelevant Text 

Node X Node Y 
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Method 2: Drag and Drop Coding.  

If you have your Nodes displayed in the List View next to the Detail View of your 
file/document, you can select the content you want to code then drag and drop the selection 
to the Node itself. The selection will still be active in the text, so you can drag it to multiple 
Nodes consecutively. 

Method 3: Quick Coding Bar (see illustration below).  

1) At the bottom of the window, there is a short-cut bar for coding. Select what you want to 
code, then choose where you want to code it in the In drop-down menu a. (Nodes, Cases 
or Relationships). You can then click on the box with the 3 dots next to this menu and 
select the appropriate Nodes from the list.  

2) If you are already in the process of coding to particular Nodes, you can select recent Nodes 
from the 2nd Code At drop-down menu b. Then select the appropriate Node from the list. If 
you want to choose more than one, click on the box with the 3 dots next to this menu and 
tick all the appropriate Nodes boxes.  

3) If you want to create a new Node, type in the name for that Node in the Code At box. 
Then click on the Icon for Code at Current Node to code it. 

 

There are also icons for c. Uncode at Selected Node and to make a Nodes from the selected 
text (d. Code in Vivo) which automatically chooses the highlight text as the Node's name (up 
to 256 characters) and as the text to that Node.  

How to See What Has Been Coded within a File 
There are 2 options for seeing what has been coded. The first is the Highlight method, which 
is useful for keeping track of where you are up to when coding. Double-click on a Data file to 
open it and the Document Tools tab will automatically become available. Click on the 
Highlight drop-down menu and select the appropriate option:  

• All Nodes (less useful) will highlight everything that is coded to a Node in yellow (including 
Case Nodes). It doesn’t tell you how it’s been coded. 

• Selected Items (more useful) will highlight the coding for a more limited range of Nodes 
which you choose from the menu (relevant ones will be in bold type). To reset these 
choices at any time, select Modify Selected Items from the Highlight drop-down menu. 

The second option not only shows you what has been coded but how it’s been coded at 
multiple Nodes. On the Document Tools tab click on the Coding Stripes drop-down menu 
and select the appropriate option (e.g., Selected Items). Colour-coded stripes will appear in 
another window on the right-hand side of the screen; one for each relevant Node in the 
document. These tell you how the sections have been coded and the coding density at each 
part of the document. When you click on one of these stripes it will highlight the coded text for 
that Node in the whole document as you scroll through (e.g., Real Estate Development). You 
can right-click on a strip to hide it from the list. To unhide a strip, select Modify Selected 
Items from the Coding Strip drop-down menu and re-tick the appropriate Nodes. You are 
also able to uncode using coding stripes by right-clicking and choosing Uncode at Node, 
Caution: this will automatically uncode all the text in that document at that Node not just the 
section of text that you can see. 
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[OPTIONAL] Coding Audio and Video Data Files 

Example: Code the audio data file for the Interview Helen. 
You can code audio and video Data files in two ways: by selecting the text in the written 
transcript just as you would for normal text documents, or by selecting sections of the media 
file via the timeline. Open the audio file for Helen in the Interviews folder.  If you want to code 
using the timeline, click and drag on the timeline to select the portion of timespan you want to 
code (e.g., 0 to 30 seconds). Right-click on the selection and choose Code (or you can click 
code on the Audio Tools tab). Choose the Node(s) you want to code the section at, 
alternatively click New Node if you need to create a new one.  

If you have a transcript as well, the portion of the transcript which is coded in the timeline is 
indirectly coded also (but the transcript will not be shown in the Node when you open it). 
When you open the Nodes, you will see a link to the section of audio and its related transcript 
on the Audio tab. To listen to the section of audio coded to the Node, in the Node Tools 
Audio tab, just click the Play/Pause button. If more than one section of text has been coded, 
right click on that section and choose Play/Pause from the menu. 

Extra Information on Working with Audio & Video: You do not need to transcribe in 
order to code Audio and Video files. However, remember that NVivo cannot search audio and 
video content when conducting Word and Text Search Queries. In addition, it becomes more 
difficult to verify the accuracy of your coding (i.e., it can take much more time to listen to the 
media file than skim the transcript). 

[OPTIONAL] Coding Pictures 
Coding pictures it is similar to tagging people on social media. Sometimes you may have to 
use this method when coding PDFs if they haven't been through optical character recognition 
(OCR), which means that the text cannot be recognised as text. 

Example: Coding a boat in the picture file Competing Water Uses. 
You can code pictures in three different ways: by selecting a region of the picture, coding text 
in the Content column of the picture log (if you have one) or by coding the entire picture file 
in one go. Again, coding the log is identical to coding normal text data. If you want to code the 
whole picture to a Node, right-click on the file itself and select Code.  

Open a picture file (e.g., Competing water uses in the Area and Township folder) and the 
Picture Tools tab will become available. If you want to code only a section of a picture (e.g., 
identify one boat in a photo), click and drag to choose the section you want to code. On the 
Picture Tools tab under click Code (or right-click on the selection and choose Code. 

PDF documents can also be coded as though they were pictures (e.g., areas of the document 
rather than words in the document). Right-click in the Detail View and select Section Mode 
then Region instead of Text. 

Uncoding Within Nodes and Data Files 
If you make a mistake when coding, or if there are references found in Nodes or the results of 
Queries that do not really fit in with the theme behind the Nodes, you can always uncode that 
section of text/picture/video/audio. Highlight the reference section to be uncoded, right-click 
on the selection and choose Uncode. All the Nodes that this section of text is coded at will be 
in black text and you can tick all the Node boxes you wish to uncode the text at. If you are 
uncoding from within an open Node, any only wish to uncode it from that Node, all you need to 
do is click the icon for Uncode from this Node on the Node Tools tab (or right-click on the 
selection and choose it from the menu).  

As mentioned previously, you can also uncode ALL the references in one data file at a Node 
using the Coding Stripes, by right-clicking on the coding stripe for the appropriate Node, and 
uncoding (with extreme caution).  
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HANDY HINT: Uncoding is easiest to do when you are reviewing the coding you have done 
within a Node, because you can select Uncode at this Node rather than having to constantly 
look for the relevant one in the list.  

Notes Area  
This Area stores links to project items in folders to make them easier to organise and find. It is 
particularly useful if you are collaborating with other researchers on the same project. 

• Memos: any memos you have made in your project are stored here. 

• Framework Matrices: create and store matrices to help you summarise what your Cases 
have said on particular topics.  

• Annotations: any annotations you have made in your project are linked here.  

• See Also Links: any hyperlinks you have made between project items. 

Creating Annotations 

Example: Annotate the Interview for Barbara. 
Select the content you wish to annotate (e.g., Barbara) and on the Document Tools tab click 
New Annotation (or right click on the selection and choose New Annotation). Enter the 
annotation text at the bottom of the Detail View. Annotated content will be highlighted in 
blue and the text will be displayed in the Annotations tab at the bottom of the window. This 
text can also be included in any text searches and/or queries.  

Creating Memos 
You can use memos to record any ideas or insights as you progress in your analysis. These can 
be linked to specific Data Files or Nodes, or Unlinked. Memos can include text, tables and 
annotations. In addition, you can code the content of memos. You can also import existing 
memos into the Memos folder. Data files that have linked memos display a memo link icon: 

 

Example: Create an Unlinked Memo for Things to Do. 
To create an unlinked memo, in the Notes Area, click the Memos folder. On the Create tab, 
click Memo, enter a name (e.g., Things to Do) and (optional) description, and then click OK. It 
will open in the Edit Mode so you can enter content. If you want to link a memo to a Data 
File/Node, right-click on the File/Node then select Memo Link and then Link to New Memo. 
Enter a name and (optional) description, then click OK.  
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Creating Links 

Example: Link text in the Barbara Interview to the Charles Interview. 
Select the content you want to link from (e.g., a selection of text from the Barbara Interview), 
and on the Document Tools tab, click the See Also Link drop-down menu and select New 
See Also Link. Click the Select button and locate the Project Item you want to link to (e.g., 
Charles in the Interview folder), and click OK. Linked content will be highlighted in pink and 
the linked item will be displayed in the See Also Links tab at the bottom of the window. 

Note: If you want to view/hide annotations and links from the Detail View, tick or untick the 
relevant box on the Document Tools tab in the View grouping 

Creating Framework Matrices 
You can create Framework Matrices with rows representing individual Cases and columns for 
specific theme Nodes. NVivo will show you the text that relates to each cell in the table in a 
separate window to make it easier to summarise it by writing your notes in each cell of the 
table yourself. 

Example: create a matrix for all the people interviewed and the Negative, Positive, Mixed and 
Neutral things they said. 

In the Notes area right-click on the Framework Matrices folder and select New Framework 
Matrix. Give the Matrix a name and optional description, then click on the Rows tab. Click the 
Select button to select Cases (e.g. in the Cases folder, look in the People folder and tick all the 
boxes in the Interview Participants folder). Then click OK. If you want to sort the Cases by 
particular Case Classification, click the select button for the Select attributes to sort the 
rows by box. Select the classification that you wish to sort by (e.g. Age Group), then click OK. 
On the Columns tab click the Select button and choose all the thematic Nodes you want in 
the columns (e.g. the Attitude child Nodes), then click OK and OK again.  

When you click on a cell in the Matrix, the coded text relating to that cell will appear in a 
window on the right-hand side. You can then summarise the text yourself within the cell of the 
table. 

Search Area  
This Area stores copies of the analyses you have run as well as their results for future 
reference, as well as containing useful “meta-folders” to help organise and find data. 

• Queries: saved Queries you have run to explore the Project data (if you have selected Add 
to Project when running the Query). You can alter the parameters and/or run them again 
at any time by double-clicking on a Query. Note: if you change the parameters it will 
overwrite the saved Query. 

• Query Results: saved results from the Queries you have run (as Nodes or Crosstabs 
[More on this next course]). 

• Node Matrices: saved tables created during Matrix Coding Queries [More on this next 
course]. 

• Sets: meta-folders which you can create to store hyperlinks to project items (e.g., a folder 
with links to all the data files you still have to code). This makes items easier to find by 
organising them in different ways. It is particularly useful if you are collaborating with other 
researchers on the same project. 

• Search Folders: meta-folders which you can create to run and produce the results of 
common searches. 
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Creating a New Set 
You can use the Sets folder in the Search area to create virtual folders with shortcut links to 
project files. Items in a Set folder are simply shortcuts to the original files. You can delete an 
item from a set without removing it from your Project. You can create an empty set to add 
items to later, or create a set based on existing Project Items. 

In the Search area, click on the Sets folder and on the Create tab click on the Set drop-down 
menu. Click on New Set and enter a name in the Name box (e.g., Check Coding) and 
(optional) Description. Click OK. Click on the new set folder and on the Create tab click the 
drop-down menu for Set and choose Add Set Members (or right-click in the relevant Set 
folder and select Add Set Members from the menu). Then select the Data files or Nodes you 
want to add. Then click OK. 

To remove items from a set, select the items you want to remove and on the Home tab click 
Delete (or right-click on the item and select Delete).  

 [OPTIONAL] Creating Transcripts 
You can create transcripts in 3 ways: Transcribe Mode, Normal Mode and by dividing the 
media into sections. For further information on importing audio and video transcripts, see 
help-nv11.qsrinternational.com 

Transcribe Mode 

Example: Transcribing the audio file for Helen. 
By using the Transcribe Mode, you can play, pause, forward or rewind as you transcribe, and 
each time press stop, NVivo creates a new transcript row and timestamp. Open the media Data 
file and click the blue Click to Edit link at the top of the file. On the Audio Tools and Edit 
tab, under the Play Mode grouping, click the Transcribe icon (the play button with a pen 
symbol). Click and drag the indicator for Play Speed (the dome-shaped icon in the Playback 
grouping) to slow down or speed up the recording. You can also adjust the volume using the 
indicator with the speaker symbol.  

Click Play/Pause to begin playing the Data file and transcribing. As soon as you do this a new 
transcript entry will be added. Enter your text in the Content column (you can pause, rewind 
and skip back while transcribing at any time). Click Stop when you have completed a 
transcription entry. This will add the end time to the Timespan field. When you press 
Play/Pause again a new transcription row will appear with a new starting timestamp. 
Continue playing and stopping in this way until you have finished transcribing. Then turn off 
Transcribe Mode on the Media tab and under Play Mode click Normal. 

Normal Mode 
You can add transcript entries directly in Normal Mode, by adding a transcript row for a 
selected timespan and entering the content. Make sure you click the Click to Edit link, then 
click and drag on the timeline to select the timespan you want to transcribe. On the Audio 
Tools tab, in the Transcript group, click the drop-down menu for Insert Row and select 
Insert Row. This will produce a new row in the transcript with the start and end times you 
selected. You can also add a new entry without a timestamp this way (e.g., to make general 
comments) simply by typing in the next entry box. 
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Dividing Media 
You can divide the media into sections by adding multiple transcript entries of equal duration. 
E.g., divide a 30min video into 2min sections then comment on dialogue/events in each. Click 
to Edit and choose the Normal mode again. On the Audio Tools tab, in the Transcript 
group, click the drop-down menu for Insert Row and select Insert Rows. In the Add 
Transcript Rows of Duration field enter the duration of each entry (e.g., 2:00 to create 
entries of 2mins duration). In the From Start Time field, enter the start time for the entries 
(e.g., 00:00:00). In the To End Time field, enter the end time for the final entry (this will be 
pre-populated with the actual end time of the audio file, but you can change this). Click OK.  

Custom Fields in Transcripts 
If you want to add columns in the transcript for information, such as the speaker’s name, click 
the File tab, and in the Info area click Project Properties. Click the Audio/Video tab and 
under Custom Transcript Fields click the Audio or Video tab. Click the New button and 
enter a name for the new field. The field will be added to all transcripts in the Project. You can 
use this field when auto coding also. 
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Other resources 
Training notes 
To access training notes, visit the Research & learn webpage anulib.anu.edu.au/research-learn 
and select the skill area followed by the relevant course. You can register for a workshop and 
find other information. 

Research & learn how-to guides  
Explore and learn with the ANU Library’s how to guides (ql.anu.edu.au/howto). Topics covered 
are: 

• Citations & abstracts 
• Data Management 
• E-books 
• EndNote 
• Finding books and more 
• Finding journal articles and more 

• Finding theses 
• Increasing your research impact 
• NVivo 
• ORCiD (Open Researcher and Contributor ID) 
• Topic analysis 
• Using Google scholar from off-campus 

Subject guides 
Find subject-specific guides (ql.anu.edu.au/subjectguides) and resources on broad range of 
disciplines. Such as: 

• History, indigenous studies, linguistics 
and philosophy 

• Criminal, human rights and taxation 
law 

• Biochemistry and molecular biology, 
neurosciences and psychology 

• Asia Pacific, Southeast Asia and East 
Asian studies 

• Engineering 
• Astronomy and astrophysics, earth 

sciences, mathematical sciences and 
natural hazards 

Online learning 
Online learning is available through ANU Pulse (ql.anu.edu.au/pulse), which can be accessed 
from both on and off campus by all ANU staff and students. 

IT skills development modules available in ANU Pulse 
• Microsoft Office (Access, Excel, OneNote, Outlook, PowerPoint, Project, Visio, Word) 
• Microsoft Office (Mac) 
• Adobe suite (Illustrator, Photoshop) 
• Type IT 

Training calendar 
Select Events » near the bottom of the Library homepage to access our events calendar with 
upcoming training opportunities displayed day by day (ql.anu.edu.au/cal). 

Feedback 
Please provide feedback about today’s workshop 

via an online feedback form (ql.anu.edu.au/survey) 

 


